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The MacBook Pro’s Desktop is the area displayed on its screen. Like a physical
desktop, you place things (in this case, icons and windows) on it to focus
your attention on them and use their content. As you work, your Desktop
naturally becomes cluttered with windows for applications, documents, and
system tools. Keeping control of all these windows helps you make the most
of your Desktop space. With all the great Desktop management tools that
the Mac’s OS X operating system offers, it's much easier to keep your

MacBook Pro’s Desktop neat and tidy than it is a physical desktop.
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Setting the Finder Desktop’s
Icon Preferences

By default on a new MacBook Pro or in a new installation of OS X on a MacBook, icons for the
MacBook Pro’s hard drive, external hard drives, DVDs, CDs, and servers do not appear on the
Desktop. This keeps the entire space on the Desktop clear for your files and folders. (If you
upgraded to a new version of OS X or used the Migration Assistant to transfer the contents of
another Mac to your MacBook Pro, the drive icons that display are whatever was previously set.)

To access drives, whether or not they appear on the Desktop, open a Finder window (choose
Filec> New Finder Window or press 3+N in the Finder, or double-click a folder or drive icon) and
click them in the Sidebar to open their contents.

Finder to see the Home folder's contents). If you don’t want a folder or file taking up

space on your Desktop, move it into a different folder within your Home folder. In addi-
tion to having a neater appearance, this also helps you work more efficiently because
it's easier to find folders and files if they're here rather than scattered on your Desktop.

Perform the following steps to show or hide Desktop icons:

1. Choose Finder> Preferences. The Finder Preferences dialog appears.
2. Go to the General pane, if it isn’t already visible.

3. Select and deselect the check boxes for the icons that you want to see and don’t
want to see, respectively, on your Desktop. For example, to hide the icon for the
MacBook Pro’s internal hard drive or any external hard drive connected to it, deselect
the Hard Disks check box. As you deselect the check boxes, the related icons disappear
from your Desktop.

use the resulting panel to configure these settings for your Desktop. The title of this

panel indicates the object for which you are configuring the view options, so it should

be Desktop. You can use this same command with any folder to set its view options.



Working with Finder Windows

Much of the time that you are working on your Desktop will involve Finder windows. Two areas of

Finder windows that you will use frequently are the Sidebar and the toolbar, in addition to the
window itself. You can use these features as they are, but you can also customize them to make
your Desktop space more efficient.

Using Finder windows

Finder windows are essentially lists of what's in whatever drive or folder you opened. Double-click
a drive or folder to open a Finder window. If you open a drive or folder from the Desktop, a new
Finder window opens for its contents. If you open a drive or folder from within a Folder window,
the Finder window displays its contents in place of whatever it was previously showing.

A quick way to open a new Finder window in the Finder is to choose Filer> New Window or to
press 3 +N. That way, you can look at contents from different locations at the same time, and even
copy or move items across them.

If you drag items from one Finder window to another, the items are moved if the Finder windows
are showing contents from folders on the same drive. They are copied if the Finder windows are
showing the contents of folders from different drives. Hold down the Option key when dragging
to copy files on the same disk, and hold down the Option key when dragging to move files to a
different disk; holding Option reverses the standard behavior.

Close unwanted Finder windows by clicking the Close button at the upper left of the window or by
pressing Shift+38+W. Note that this shortcut is new to OS X 10.9 Mavericks and had been just
3 +W in previous versions of OS X.

Mavericks introduces a new capability in Finder windows called Finder tabs that reduces clutter
on the Desktop. It works just like a browser’s tabbed panes do: Each pane has its own tab that
you click to switch to that pane, as Figure 1.1 shows. Create a new tabbed pane by choosing
Filew> New Tab or pressing 3+T. You can drag items from one tab to another: From the open
pane, just drag the item to the tab of the other pane.

To close a tabbed pane, hover the pointer over its tab, and click the X icon that appears on the left
side of the tab, or just press 3+W to close the active (open) pane.
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1.1 OS X Mavericks lets you have multiple tabbed panes in the same Finder window, to decrease
Desktop clutter.

Using and configuring the Sidebar

The Finder’s Sidebar makes it easy to get to specific locations, meaning folders, drives, and even files.
It comes preloaded with a set of aliases (shortcuts) to common locations, but you can add items to,
or remove them from, the Sidebar so it contains aliases to the items you use most frequently.

The Sidebar is organized into sections, as shown in Figure 1.2. You control which ones display by
using the Finder Preferences dialog (choose Finder=> Preferences). The process is similar to how
you control which disk icons appear on the Desktop, except that you go to the Sidebar pane in the
dialog rather than the General pane, and then check and uncheck the desired options to control
what displays, as shown in Figure 1.3.
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In the Sidebar itself, you can show or hide the contents of a section by hovering the pointer over a
label, like Devices, and clicking the Hide or Show label that appears to its right to control if the sec-
tion’s contents appear.
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1.2 Use the Sidebar to quickly move to the items that you want to view in a Finder window.

So what are the sections? The Favorites section holds aliases to the folders on your MacBook Pro
that Apple expects you open most frequently; you can customize it so it reflects the folders you
open the most. The Shared section holds locations you are accessing on a network, such as a
shared hard drive. The Devices section includes hard drives and disk images that are mounted on
your MacBook Pro. And the new Tags section in OS X Mavericks shows files and folders that you
tag with specific labels, such as those belonging to a specific project.

Using the items on the Sidebar is simple (which is why it's so useful). Simply click the icon with
which you want to work. What happens when you click depends on the kind of icon it is. The fol-
lowing are the common items:
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All My Files. When you click this icon, all
the files you've worked with appear in the
Finder window. You can use the view and
browse tools to access any file you need.

AirDrop. When you click this icon, you

can see other users connected to the same
Wi-Fi network and have their AirDrop
folder open—if they're using a Mac made
in 2011 or later and running OS X 10.7 Lion
or higher. You can send files to other users
by dropping them on the person’s icon in
the AirDrop window, and they can share
files with you in the same way.

Applications. If the icon is for an applica-
tion, the application launches.

Documents. Clicking a document'’s icon
opens the associated application, and
you see and work with the document’s

contents.

Folder. When you click a folder, you see
its contents in the Finder window.

Shared folder or drive. When you select
a shared network resource, you see either
the login dialog, or if your MacBook Pro is
configured to automatically log in to the
resource, you see its contents.

Devices. When you select a device, its
contents are displayed in the Finder
window.

Tags. If you click a tag icon, you see all
files and folders using that tag—regard-
less of their location on the Mac— in the
Finder window.
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1.3 You can determine the kinds of resources
available in the Desktop via the Finder
Preferences dialog’s General pane (top) and
what appears in the Sidebar via its Sidebar
pane (bottom).
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Each type of Sidebar item has a distinctive icon, making what it represents easy to

determine.

You can add an alias to a drive or folder to the Sidebar by dragging its icon from the Finder window
into the Sidebar’s Favorites section. To add an alias in the Sidebar to a file, select it and press
Control+38+T. Drag any of these aliases out to remove them from the Sidebar (the original items
are not deleted from the Mac, of course).

of the other sections is determined by the Preferences settings, what your MacBook
Pro is connected to on the network, and the mounted devices or disk images. If you

drag an icon onto something in the other sections, it may be copied there instead

(for example, when you drag an icon onto a disk’s icon).

To copy the file into a Sidebar location (rather than open that location in another Finder window),
hold down the Option key while you move the file’s icon onto a folder’s or drive’s alias in the
Sidebar. But if you drag an item onto a shared location in the Sidebar, rather than to a folder or
drive, it is copied to that location instead of moved; to move an item to a shared location via the
Sidebar, hold down the Option key.

To change the order of items within the Sidebar, drag them up or down the list. As you move an
item between others, they slide apart to show you where the item you are moving will be. (You
can move items within their sections, as well as from the Devices section to the Favorites section
(but not in the reverse direction, or to or from other sections).

Using and configuring the toolbar

The toolbar appears at the top of the Finder window and contains buttons and pop-up menus that
you can use to access commands quickly and easily. You can configure the toolbar so it contains the
tools you use most frequently. When you open a Finder window, the toolbar appears at the top.

using the slider at the bottom right of the window. If you don't see it, choose

eniu View > Show Status Bar.
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The following default tools appear on the toolbar (as grouped from left to right):

@ Back and Forward buttons. These move you along the hierarchy of Finder windows
that you've moved through (just like the Back and Forward buttons in a web browser).

@ View buttons. You can change the view of the current window by clicking one of the View
buttons. For example, to see the window in List view, click the second button in the
View group (its icon has horizontal lines). The four buttons (left to right) are Grid, List,
Columns, and Cover Flow.

@ Arrange pop-up menu. This menu lets you arrange the contents of the window. For
example, you can rank items by name, date last opened, size, and so on. Choose None to

remove the arrange settings.

@ Action pop-up menu. This menu contains a number of useful contextual commands.
These are the same as those that appear when you right-click an item. Options can
include Move to Trash, Get Info, and Make Alias.

@ Share menu. Use this menu to share a selected item; the options you see depend on
the type of item you have selected. Options can include Email, Message, AirDrop, Flickr,
and so on.

@ Tag button. Use this new capability in OS X Mavericks to apply a tag to the selected
item. A pop-up opens in which you can select an existing tag or type in a new one. Items
can have multiple tags.

|D|

[\[STWl have the Mac reverse the left and right sides of the trackpad (or external mouse if

right-clicked. A right-click is also called a secondary click, because it's possible to

you're using one) to accommodate left-handed users. By default, a standard click,

such as to select an item, is done on the left. Another way to do a right-click is to hold
down Control and do a standard click.

@ Search bar. You can search for items on the Mac by typing text or numbers into the
Search bar. As you type, items that match your search term appear in the Finder window.
By default, OS X searches both file names and file contents. But if you wait a moment
before pressing Return to begin the search, a menu appears to let you limit the search to,
for example, filenames or types of files, as Figure 1.4 shows.

10
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1.4 When you search files, you can narrow the search by pausing in the Search bar briefly to open
amenu.

You can change what appears in the toolbar. Follow these steps:

1. Open a Finder window.

2. Choose Viewr> Customize Toolbar. The Toolbar Customization sheet appears, as
shown in Figure 1.5.

3. Toremove a button from the toolbar, drag its icon from the toolbar outside the
Finder window. When you release the trackpad, the selected button disappears. (You
can always add it back later.)

4. To add a button to the toolbar, drag it from the sheet and drop it on the toolbar
where you want it to appear. When you release the trackpad, the selected button is
added to the toolbar.

11
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1.5 Use the Toolbar Customization sheet to define and organize the tools on your toolbar.

5. Using the Show menu, choose how you want the buttons on the toolbar to appear.
Your options are Icon and Text, Icon Only, and Text Only.

6. When you finish customizing the toolbar, click Done. The Toolbar Customization
sheet closes, and you see your customized toolbar in any Finder windows.

To return the toolbar to its default state, open the Toolbar Customization sheet and

drag the default set of buttons onto the toolbar.

Working with the Dock

The Dock is an important part of your Desktop space. By default, it appears at the bottom of the
Desktop, but you can control many aspects of its appearance, including where it is located and, to
a great degree, how it works. The Dock is organized into two general sections. The area to the left

12



of the application/document separation line
(the faint, dark line a few icons to the left
of the Trash icon) contains application icons.
The area to the right of this line contains
icons for documents, folders, minimized
Finder or application windows, and the Trash/
Ejecticon.

When folders appear on the Dock, they become
stacks by default. When you click a stack, it
pops up into a fan or appears as a grid (depend-
ing on how many items are in the folder), as
shown in Figure 1.6, so you can work with the
items it contains. You can disable this feature
for any folder so it behaves more like a normal
folder (more on that shortly).

You can perform all the following functions
from the Dock:

@ Seerunning applications. Whenever

Open in Finge,

About pg wnloads

Blank W-9.pdf

Google page calculator.x|sx

Cookbook

ScreenUtil

1.6 Clicking a folder’s icon on the Dock causes its
contents to either appear in a grid or fan out (as
shown here), depending on how many items it
contains and your preferences.

an application is running, you see its icon on the Dock. If the related preference is set

(more details on this a bit later), a small, glowing blue light is located at the bottom of

every running application’s icon. Application icons also provide information about what

is happening with those applications. For example, when you receive e-mail, a badge on

the Mail application’s icon changes to indicate the number of messages you have

received since you last read messages.

@ Open applications, folders, minimized windows, and documents quickly by clicking

the related icon. You can drag applications from the Desktop or a Finder window to

the Dock'’s left side and can drag folders, files, and drives to the Dock’s right side to put

an alias to the items on the Dock for one-click access later. Or right-click a running appli-

cation’s icon, and choose Options=>Add to Dock to keep it in the Dock. Drag an icon out

of the Dock to remove it from the Dock (the item is not deleted from your Mac). You can

rearrange the application icons on the Dock by dragging them to the Dock location

where you want them to reside.

item you want to bring to the front.

~ Quickly switch among open applications and windows by clicking the icon for the

13
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Be alerted about issues. When an application needs your attention, its icon bounces on
the Dock until you move into that application and handle the issues.

Control applications and switch to any of their open windows. When you right-click
the icon of an application, a contextual menu appears. When the application is running,
this menu lists commands, as well as all the open windows related to that application.
When the application isn’t running, you see a different set of commands (such as the
Open command).

Customize its appearance and function. You can control how the Dock looks, includ-
ing its size, whether it is always visible, and where it is located using the Dock system
preference, which | describe later in this chapter.

behavior—choose @ System Preferences to open the System Preferences appli-

cation, and click the icon for the specific system preference you want to adjust, such

as Dock or Security & Privacy.

Understanding how applications
and folders work in the Dock

Two icons on the Dock are unique and always there: the Finder and the Trash.

@

14

When you click the Finder icon (anchored on the left end of a horizontal Dock or at the
top of a vertical one), a Finder window opens (if one isn't already open). If at least one
Finder window is open, clicking the Finder icon brings the Finder window you used most
recently to the front.

The Trash icon is where all folders and files go when their time is done. When the Trash
contains files or folders, its icon includes crumpled paper so you know something is in
there. When you select an ejectable item (such as a DVD), the Trash icon changes to the
Eject symbol. You can drag a disc, drive, volume, or any other ejectable item onto that
icon to eject it.

appears. Click an icon to switch to its application, or while holding down 3§ repeat-

eniu edly press Tab to cycle forward through the list, or repeatedly press Shift+Tab to

cycle backward through the list. When you release the keys, you switch to the
selected application. You can also type Q to quit the selected application in the
Application Switcher.
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Unless an application is permanently added to the Dock (in which case, its icon remains in the
same position), the icon for each application you open appears on the right (or bottom) edge of
the application area of the Dock while running and then disappears when you quit the
application.

Unlike open applications, open documents don’t automatically appear on the Dock. Document
icons appear on the Dock only when you minimize a document’s window from the application
using it or when you manually add them by dragging their icon from a Finder window.

In what Apple calls App Exposé, you can see a list of all open windows in a running application by
right-clicking the application’s Dock icon and choosing Show All Windows from the contextual
menu that appears. Or just press the default shortcut (usually Fn+F10 or Control+down arrow); the
same shortcut restores the regular view.

When you minimize an application window, it is pulled by default into the Dock using the Genie
Effect. You can change this so the Scale Effect is used instead, via the Dock system preference. You
can also change where the minimized application’s document windows go: into the application’s
icon or into the document section of the Dock. When in the document section of the Dock, mini-
mized windows are marked with the related application’s icon in the lower-right corner of the
Dock icon so you can easily tell from which application the windows came. Minimized windows
disappear from the Dock when you maximize them or when you close the application from which
they came.

you can quickly open one of its windows by right-clicking the application icon or

[T Il Pressing the default shortcut (usually Fn+F10 or Control+down arrow) and choosing
the window you want. (The application’s icon remains in the Dock, so you know it's

still running.)

When you place a folder’s icon on the Dock, it displays as a stack. A stack has some special charac-
teristics, which is why it isn't just called a folder (however, you can configure a stack to behave like
a folder). Two stacks are installed on your Dock by default: Downloads and Documents.

Stack icons sometimes take on the icon of the most recent file that has been placed into them. For
example, if you last downloaded a disk image file, the Downloads stack icon is the one for a disk
image. When you place an image into your Pictures folder and have that folder installed on your
Dock, its icon is a thumbnail of the last image you placed in it.

15



When you click a stack icon, its contents fan
onto the Desktop if there are only a few of
them, or open into a grid if there are many.
Name

clicking it. You can open the folder’s contents v Date Added

in a Finder window by clicking Open in Finder. Date Modified

Date Created
To configure how an individual stack’s icon Kind

You can access an item on the fan or grid by

behaves by using its contextual menu, right-
click the stack icon to reveal its menu, as

shown in Figure 1.7.
g Folder

The following options are included in the menu: v Stack

@ Sort By. Choose the attribute by which
you want the items in the stack to be Fan
sorted. For example, choose Date Added Gl'id

List
v Automatic

to have the most recently added con-
tent appear at the bottom of the fan (if
the stack is set to fan, of course).

@ Display As. Choose Stack to have the Dptiﬂ ns -
icon look like a stack, or choose Folder
to replace the stack icon with the fold- Open “Downloads”
er's icon. The only difference is that
when you select Folder, you always see
the folder’s icon on the Dock, as
opposed to the icon of the most
recently added item, which is what you

see when Stack is selected.

Dock settings are specific to each user account; see

tion. One user’s Dock settings do not affect another’s.

Note

@ View Content As. Choose Fan to see the default fan layout for the stack (until it contains
too many items, at which point it uses the grid instead). Select Grid to have the folder’s
contents always appear in a grid. Select List to always display the contents in a columnar

16
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list; this is useful for folders that contain subfolders because you can select a subfolder to
open its contents. Select Automatic to have OS X select the most appropriate view based
on the folder’s contents.

@ Options. Choose Remove from Dock to remove the icon from the Dock. Choose Show in
Finder to open a Finder window showing the folder’s contents.

@ Open. Choose this command to open the folder on the Desktop.

Changing the Dock’s appearance and behavior

The Dock offers several behaviors that you can change to suit your preferences. These steps walk
you through how to change various aspects of the Dock’s appearance:

1. Open the Dock system preference.

2. Drag the Size slider to the right to make the default Dock larger, or drag it to the
left to make it smaller. Note that the Dock doesn’t grow any larger when it's com-
pletely full of icons, even if the slider isn't all the way to the right.

OS X Mavericks automatically appears on the active display, meaning the one where
the pointer is. In previous OS X versions, the Dock appeared only on the primary

display, which you could change in the Displays system preference’s Displays pane.

3. Select the Magnification check box if you want to magnify an area of the Dock
when you point to it. Drag the Magnification slider to the right to increase the level of
magnification or to the left to decrease it. This can make identifying items easier, espe-
cially if many items are on the Dock or when it is small.

4. Select the position of the Dock on the Desktop by clicking Left, Bottom (the
default), or Right.

5. From the Minimize Windows Using pop-up menu, choose Genie Effect to pull win-
dows down to the Dock in a swoop when you minimize them, or choose Scale Effect
to shrink them straight down into the Dock.

6. If you want to be able to minimize a window by double-clicking its title bar, select
the Double-Click a Window’s Title Bar to Minimize check box.

7. If you prefer windows that you minimize to move onto the related application’s
icon instead of to a separate icon on the right side of the dividing line, select the
Minimize Windows into Application Icon check box. With this setting enabled, you

17
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must open the application icon’s menu and select a minimized window to reopen it
from the Dock, or switch back to the application and use its Window menu to choose the
minimized window (unless the minimized window is also the application’s active win-

dow, in which case you move into it directly).

8. By default, application icons bounce as the application opens. If you don’t want this
to happen, deselect the Animate Opening Applications check box.

9. If you want the Dock to be hidden automatically when you aren’t pointing to it,
select the Automatically Hide and Show the Dock check box. If you set the Dock so
that it is hidden except when you hover the pointer at the bottom of the screen, you can
use more of your display.

10. Toshow the glowing dot icon under running applications, select the Show Indicator
Lights for Open Applications check box. These lights are useful because they help you
more easily identify open applications when you glance at the Dock, even hidden ones.

You can turn Dock Hiding on or off at any time by pressing Option+36+D.

Using the Launchpad

If you've used an iPhone, iPod touch, or iPad, you already know how to use the Launchpad on the
Mac because it works in exactly the same manner as the Home pages on those devices. If you like
the iOS style of accessing apps, the Launchpad provides one-click access to all your applications
and utilities, and you can organize the Launchpad to make it work efficiently for you.

()

(YRS on an iPhone, iPod touch, or iPad, you can also store web page icons.

Launchpad is that only application icons can be stored on the Launchpad, whereas

Click the Launchpad icon on the Dock (it is located just to the right of the Finder icon by default) or
perform a three-finger pinch (three fingers pinched against your thumb) on the trackpad. This
preference is enabled by default in the Trackpad system preference. The Launchpad then fills the
Desktop, and you see icons on the current page, as shown in Figure 1.8. To move to a different
page, drag two fingers on the trackpad to the left or to the right. As you drag, the page flips to the
next or previous page. You can also search for an app by entering all or part of its name in the
Search field at the top of the Launchpad.
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is hidden when the Launchpad is open. You can also use the Application Switcher
while the Launchpad is displayed.

To open an application, click its icon. The Launchpad closes and switches to that application. Click
a folder in the Launchpad to access the applications stored in it. The folder then expands, and you
see the icons it contains, as shown in Figure 1.9.

To close the Launchpad without opening an application, click it (but not an application’s icon),
perform a three-finger expand gesture on the trackpad, or press Esc.

( ] The Launchpad is actually an application. Therefore, you can add its icon to the

Sidebar, open it by double-clicking its icon in the Application folder, and so on.
Note
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1.9 To access an app stored in a folder, click the folder’s icon and then click the application’s icon.

You can organize the icons on your Launchpad to make accessing them easier and faster. To
change the location of icons on the Launchpad, open it and drag the icon you want to move to the
desired location. You can change its location on the current page, or you can drag it off the screen
to the left or right to move it to another page (you have to linger at the edge of the screen until the
page changes). As you move one icon between others, they shift to make room for the one you are
moving. When the icon is over the location you want, release it.

To create a new folder, drag one icon on top of another. Launchpad creates a new folder and tries
to name it according to the type of applications you place together. The folder opens, and you
see the icons stored there. To change the folder name, select it. When it is highlighted, type its

new name.

You can place icons into existing folders by dragging them on top of the folder in which you want
to place them. You can also reorganize icons within folders by dragging them around when the
folder is open. To remove an icon from a folder, drag it outside of the folder window until the
folder closes. To delete a folder, drag all its icons outside of it; when you remove the second to last
icon, the folder disappears (folders can’t contain just one icon).
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You can remove applications purchased from the Mac App Store by clicking and holding an icon.
After a moment, the icons begin to jiggle and the Remove button (X) appears. Click the Remove
button, and then click Delete at the prompt. Removing an application from the Launchpad also
deletes it from your MacBook Pro, so make sure you really don’t want it before completing this
action. To return the Launchpad to normal without deleting an application, click outside of any
application icon.

( ] To remove applications that you didn’t download from the App Store, run the appli-

cation’s uninstaller or drag it to the Trash, and then empty it.
Note

Managing Your Desktop’s Windows

OS X gives you a few ways to manage your Desktop’s windows. As explained earlier, you can use
the App Exposé feature in the Dock to display the windows for a running application, and you can
use the Application Switcher to move among open applications. But those are methods to move
among running applications and their windows, not to manage the Desktop itself.

OS X provides two basic methods for managing Desktop windows: the Show/Hide feature avail-
able to each application and the Mission Control application.

You can make all applications except the one you're running disappear from the Desktop by
choosing Hide Others from their application menu or pressing Option+38+H. For example, in Mail,
choose Mail=> Hide Others. (They're still running, as you can see in the Dock or the Application
Switcher.) You can also hide the current application by choosing Hide in the application menu
(such as Word => Hide) or pressing 36+H. To restore all hidden applications, choose Show All in the
application menu (such as iTunes Show All).

Mission Control offers more complex controls, such as letting you create multiple Desktops (also
called spaces) that you then run applications in. That way, you could have all the applications for a
specific project running in one Desktop and your basic applications like Safari and Mail running in
another. You then switch Desktops to see just those application groups. (You can access any applica-
tion at any time via the Dock or Application Switcher, no matter what Desktop they are assigned to.)

To open the Mission Control view, click its icon on the Dock or swipe four fingers up the trackpad
(the default gesture; see Chapter 5 for more information) or press Control+up arrow (the default
shortcut, which you can change in the Mission Control system preference). You then see the
thumbnails for the following items at the top of the screen, as shown in Figure 1.10:
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Contacts

Mail

Mission Control

1.10 Mission Control shows all the open windows on your Desktops.

@ Dashboard, the little-used application that lets you run widgets.
@ Your spaces, named as Desktop X (where X is a sequential number).

@ Applications that are open in full-screen mode (here, Safari).

In the center part of the window, you see all the applications running in the current Desktop, as
well as their open windows. The application’s icon and name accompany its windows. The Dock
appears in its default location, and you can use it just as you would when working outside of
Mission Control. At top are the Desktops, or spaces, you've created, as well as any applications run-

ning in full-screen mode (here, Safari).

Managing windows on the Desktop

As you work on documents, move to websites, check your e-mail, choose tunes to listen to, and all
the other things you do on your MacBook Pro, you can accumulate lots of open windows on your
Desktop. This makes it easy to multitask so you don't have to stop one activity to start another. The
downside, though, is that it's easy to lose track of where the specific window you want is located,
or you might have a hard time getting back to the Desktop.
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Mission Control helps you manage screen clutter from open windows with these three modes:

@ Show Desktop
@ Show the active application’s windows

@ Show all windows on the current Desktop, all Desktops, the Dashboard, and full-screen apps

Each mode has a specific use, and you access them in slightly different ways. The Mission Control
application doesn’t need to be running for the first two modes, just the third.

Showing the Desktop

Showing the Desktop is useful when the Desktop on which you are working is so cluttered with
application windows that you have a hard time finding anything. To clear away all your windows
in one sweep, press the keyboard shortcut Fn+F11 (you can change this default in the Mission
Control system preference). Now you can access the icons of folders, files, and drives on the
Desktop without distraction. Your applications are still running, and you will see the edges of their
windows pushed to the four sides of the Desktop. Press the shortcut again to see the normal
Desktop with all open windows.

Showing the active application window

When you are working with multiple windows in the same application, it can be tough to get back
to a specific window if you can't see all them at the same time. Press the keyboard shortcut
(Control+down arrow, by default) or swipe down with four fingers (the default gesture) to see all
open windows for the current application, as shown in Figure 1.11. Yes, this is the App Exposé view
covered earlier that is also available from the Dock.

At the top of the screen, you see the windows that are currently open on the Desktop. Below
these, you see any windows that are hidden or those that you worked with previously that are now
closed (such as documents you have edited).

To switch to a window, click it; it is highlighted in blue when you hover the pointer over it. The
window becomes active (if it is for a closed document, the document opens) and moves to the
front so that you can use it. The rest of the open application windows then move to their previous

positions.

move through them. You can also use & +Tab to open the Application Switcher bar,
which shows all open applications, and then keeping holding 38 as you press Tab to

move to the application on which you want to focus. When you release the 38 key,

the windows for the selected application appear.
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Activity

When you have many windows open in an application, Mission Control makes it easy to move
into a specific one.

In this mode, you see Mission Control, as previously shown in Figure 1.10, which shows your
Desktops, applications running in full-screen mode, and the windows open in the active Desktop.
Click a window to switch to it, or click a Desktop to switch to it, if you have multiple Desktops.

As you use your MacBook Pro, it’s likely that you'll develop sets of tasks that you work on at the
same time. For example, you might use Word to create text and Photoshop to create the images
for a book. These kinds of activities invariably involve lots of windows. Although you can use
Mission Control to manage all the open windows for an application, it's not very efficient because
you can focus only on one window at a time, so it can still take some work to get to the windows

you want to use.



But you can use Mission Control to create collections of applications and their windows on sepa-

rate Desktops, also called spaces. This way, you can jump between sets easily and quickly. For
example, if you use several Internet applications, you can create an Internet Desktop specifically
for those, such as an e-mail application and web browser. To use your Internet applications, just
open that Desktop and the windows are all in the positions you last left them. You might have
another Desktop that contains Contacts and Calendar. You can then use these applications by
switching to their Desktop. Multiple Desktops make moving to and using different sets of win-
dows fast and easy. They also improve the efficiency with which you work.

To create a Desktop, hover the pointer over the upper right of the Mission Control view. When a
large + icon (the Add Space button) appears, click it. Now drag any desired applications in the
main Mission Control view to that Desktop to move them there. When not in Mission Control view,
you can assign applications to the currently open Desktop by right-clicking the application icon in
the Dock and choosing Options=> This Desktop, as Figure 1.12 shows. To assign an application to
all Desktops (that is, for applications you want easily available no matter what Desktop is open),
choose Options=> All Desktops instead.
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1.12 Assign an application to the current Desktop or to all Desktops using the Dock’s contextual menu.
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To unassign an application from a Desktop, display that Desktop, right-click the application icon in
the Dock, and choose Options=> This Desktop so the check mark beside that option disappears. To
unassign an application from all Desktops, choose Options=> None. Note that unassigning does
not quit the application; it prevents the application and its windows from automatically opening
in a specific Desktop the next time you run it.

A quick way to change Desktops—without needing to be in Mission Control view—is to swipe
three or four fingers (depending on your trackpad's settings) to the left on the trackpad to move to
a later space, or swipe to the right to move into a previous space. When you stop on a space, it
becomes active and the windows open in it appear the same as they were the last time you used
that Desktop.

S

Note | Eizcae=s

depend on the preferences you set using the Trackpad and Mission Control system

When there are too many Desktops and full-screen applications for the names of each to be dis-
played, point to a Desktop or application; it is magnified and its name appears.

I[ Jl You can reorganize your Desktops by dragging their icons at the top of the Mission

Control view.

Note

To close Mission Control without changing spaces or windows, swipe four fingers down the track-
pad or press Esc.

Configuring Mission Control

Now that you have a good understanding of Mission Control, you can configure it by setting your
Mission Control preferences:
1. Open the Mission Control system preference, shown in Figure 1.13.

2. Deselect the Show Dashboard as a Space check box if you don’t want the
Dashboard to be accessible in Mission Control view.

3. If you don’t want Mission Control to automatically rearrange spaces based on the
ones you've used most recently, deselect the Automatically Rearrange Spaces
Based on Most Recent Use check box.
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l?] Show Dashboard as a Space
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With a single keystroke, view all open windows, windows of the current application, or hide windows to locate
an item cn the desktop that might be covered up.
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Application windows: | ~ | |- 7|
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Hot Corners... | ? |

1.13 Configure Mission Control preferences to tweak how its features work.

4.

Deselect the When Switching to an Application, Switch to a Space with Open
Windows for the Application check box if you don’t prefer that. If you select this
option, when you switch applications, you also move into the Desktop in which the
switched-to application has windows open.

. Deselect the Group Windows by Application check box if you don’t want windows

to appear on the Desktop clustered based on their application. Deselecting this
option makes it harder to tell what application will open when you click a window.

If you don’t want each monitor attached to your MacBook Pro to display as its own
Desktop, deselect the Displays Have Separate Spaces option. OS X Mavericks intro-
duced this option. If selected, each monitor is automatically its own Desktop, so you
can’t have Desktops that go across multiple monitors. Deselecting this option makes
Desktops display across all monitors, as if they formed one very large monitor. (I explain
how to set up multiple monitors later in this chapter.)
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7. Inthe Keyboard and Mouse Shortcuts section, configure the keyboard shortcuts
and mouse clicks to activate Mission Control, activate application windows (App
Exposé), and show the Desktop and Dashboard. Use the menus on the left to set key
combinations and the menus on the right to set mouse-clicks. If you use function keys
such as F10, you must hold down Fn for them to work; without holding Fn, these func-
tion keys control aspects of the MacBook Pro’s hardware, such as sound volume and
screen brightness, as the labels on the MacBook Pro’s keys show. To use modifier keys
with a function key, such as Option, hold down the modifier keys while selecting from
the menu. Using modifier keys with function keys usually means you don't have to hold
Fn. For example, if you hold down Option, the menus show \C F1 through X F16; if you
hold down Control and 38, the menus show A38F1 through A38F16.

8. Click the Hot Corners button to open the Hot Corners sheet. Use this sheet to set an
action to occur when you point to that corner of the screen. For example, if you want the
Launchpad to open when you move the pointer to the upper-right corner of the screen,
select Launchpad on the menu in that location.

Using Applications in
Full-Screen Mode

Many applications, such as Safari, Mail, iMovie, Aperture, and even the Finder, really benefit from
all the Desktop room they can get to work more efficiently. That's why OS X lets applications
appear in full-screen mode. In this mode, the application takes over the entire screen and its menu
bars are hidden, as shown in Figure 1.14.

for all software. You can tell if an application supports full-screen mode because it

has an icon of two opposing arrows in the upper right of its window.

Explore full-screen mode in applications that you use frequently to see if it helps you use them
more efficiently. These pointers may help you:

@ Activate full-screen mode. Choose View > Enter Full Screen, or press Control+38+F.
The application’s current window fills the screen and the menu bars are hidden.

@ Reveal the menu bars. Hover the pointer at the top of the screen. After a few seconds,
the menu bars appear and you can access them just as you do when you aren’t working

in full-screen mode.
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@ As covered earlier in this chapter, applications running in full-screen mode appear
as spaces in Mission Control view.

@ Exit full-screen mode. Choose View = Exit Full Screen, or press Control+38+F.
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1.14 Using an application in full-screen mode gives it the most screen real estate possible.

Configuring Notifications

Many applications use notifications to communicate information to you. For example, Mail noti-
fies you when you receive new messages, Calendar alerts you to upcoming events, Reminders
reminds you about various things, and so on. The OS X Notification Center provides a central point
of control for, and configuration of, the notifications with which you work.

Working with the Notification Center

To view the collection of notifications you have received, click the Notification Center menu
located on the right end of the menu bar. The Notification Center pane appears, as shown in
Figure 1.15. Notifications are grouped by the application from which they come. You can scroll the
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list to see all the notifications you have received. The order in which the groups are shown is deter-
mined by a preference setting (covered later in this chapter). When this is set to Manually, you can
drag sections up or down the list.

Finder File Edit View Go Window Help )

@ Calendar

A Paul eligible for new

1.15 The Notification Center provides a one-stop shop for the information that various applications are
managing for you.

To see the details of a notification, click it. You then move into the related application and can
work with the information. For example, if you click an e-mail notification, you are switched to Mail

and can read the full message.

Of course, you don't have to open the Notification Center to see notifications. OS X provides sev-
eral other ways to see notifications:

@ Badges. These are counters that appear on an application’s icon to let you know how many
of something you have, such as e-mail messages, texts, updates for applications, and so on.

@ Banners. These are small messages that appear in the upper-right corner of the screen, as
shown in Figure 1.16, when something happens, such as when you receive a message.
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Banners contain the icon of the app from
which they come, and they can also
show you a preview. They are nice
because they don't interfere with what
you are doing. If you ignore a banner, it
disappears after a few seconds. If you

in 7 minutes

@ pick up kids from soccer

1.16 Banners are good because they don't
require any action on your part.

click it, you move into the application that produced the banner. If you receive a new ban-

ner while a previous one is still visible on the screen, the second one displaces the first so

that the latest one is displayed.

@ Alerts. This is another means that appli-
cations use to communicate with you.
There are alerts for many types of
events, such as texts, reminders, missed

call notifications, and so on. The main

Diamond Heights Park | Snooze |

@ pick up kids from soccer p... | Close |
in 7 minutes S

1.17 Alerts require action to get rid of them.

difference between a banner and an alert is that alerts remain on the screen until you

take some action, such as clicking Close or Snooze to dismiss an alert for an event, as

shown in Figure 1.17.

@ Sounds. These are audible indicators that something has happened. For example, when

something happens in the Game Center, you can be notified via a sound.

OS X Mavericks lets you respond to some notifi-
cations without opening their applications, as
Figure 1.18 shows. If you hover on the right side
of their banners, you'll see buttons for actions
such as Reply that you can take immediately
from the notification itself. Examples include
Mail and Messages.

You can also initiate social media posts to
your Twitter, Facebook, and/or LinkedIn

Ingall W. Bull 1l
15 minutes ago
Pacing up now

| Cancel

iMessage

1.18 Some banners let you reply to notifications
without opening their associated application. In

these cases, a window opens, such as the one for
Messages here, to let you enter your reply.

accounts from the Notification Center. Open it, scroll up to the top, and click the button for the

desired service. (They must be configured in the Internet Accounts system preference, which was
called Mail, Contacts, & Calendars before OS X Mavericks.)

You can also turn off notifications at the top of the Notification Center, such as when giving a presen-

tation or simply when you want to work undisturbed. Use the Do Not Disturb switch (refer to Figure

1.19) to control whether notifications appear (it was called Show Alerts & Banners before OS X

Mavericks).
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As covered later in this chapter, you can enable or disable notifications, and configure them for

specific applications. Applications also send individual notifications to the Desktop, such as when
Calendar sends an alert about an event. The following sections explain several options you can
configure for these notifications.

Configuring Notifications’s display

You can configure your notifications on the Notifications system preference, shown in Figure 1.19. The
applications for which you can configure notifications are shown in the list on the left side of
the window. When you select an application, its notification options are shown in the right side
of the window. You can configure each application’s options individually.

@eo0o Motifications
[« > || Showall | Q

Notification Center shows your alerts in the upper-right of your screen, without interrupting what
you're doing. Show and hide Notification Center by clicking its icon in the menu bar.

Do Not Disturb Messages alert style:

In Motification Center

Share Buttons

=
None et
~=  Messages
b [
. BAHoes, SD s B nr s Banners appear in the upper-right corner and go away
Mail automatically. Alerts stay on screen until dismissed.

. Calendar [ Show notifications when display is off or locked
‘17:' (™ Show message preview | when unlocked * |

Reminders
N

[ Show in Notification Center: | 5 Recent ltems 3 |
@ FaceTime o Badge app icon
‘_,r\ [E] Play sound for notifications

@ Safari

Sort Notification Center: | Manually % | (2)

T

1.19 The Notifications system preference lets you configure how applications notify you.
These are some highlights and suggestions about configuring notifications:

@ Use the alert style buttons to configure the type of notifications the application
uses. The options are None, Banners, and Alerts.
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@ Use the Show in Notification Center check box and menu to determine if the appli-

cation’s notifications are shown in the Notification Center, and if so, how many are
shown. If this is not selected, notifications from the application do not appear in the
Notification Center.

@ If you want the notifications to display on the login screen, such as when the
MacBook Pro has locked the screen due to non-use (as set in the Security & Privacy
system preference) or when you've logged out of an account, select the Show
Notifications When Display Is Off or Locked check box. This feature is new to OS X
Mavericks. A related feature available for some applications, such as Mail and Messages,
is the Show Message Preview check box. Select it to display part of the message in the
banner. Use its adjacent menu to determine whether those previews display always or
only when the MacBook Pro’s screen is not locked.

@ If you want the application’s icon on the Dock (or elsewhere) to display a badge
when you have new information, such as new messages, select the Badge App Icon
check box.

@ Todisable the sound associated with an application’s notifications, deselect the
Play Sound for Notifications check box.

@ Use the Sort Notification Center menu to determine how applications are listed in
the Notification Center pane. Choose By Time if you want the most recent information
to appear toward the top of the pane, or Manually if you want to manually configure the
order by dragging application sections up or down the pane.

To disable alerts and banners, scroll to the top of the Notification Center and set the Do Not
Disturb switch to the On position. All alerts and banners are suppressed until you set the switch to
the Off position again.

As Figure 1.20 shows, you can also set a regular time for when Do Not Disturb is automatically
engaged, such as overnight, and control whether Do Not Disturb activates automatically when the
MacBook Pro is asleep (so messages aren't visible on a MacBook in a public location when you've
stepped away) or when you are connected to an Apple TV (so you don’t disturb your movie or
presentation). These controls are new in OS X Mavericks.

Additional controls over Do Not Disturb new to OS X Mavericks are the two When Do Not Disturb
Is Turned On options: Allow FaceTime Calls From and Allow Repeated Calls. If selected, Allow
FaceTime Calls From tells the MacBook Pro to ring through FaceTime calls from either everyone or
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just the people you've marked as Favorites in FaceTime, based on what option you choose in the

adjacent menu. If selected, Allow Repeated Calls lets a person try to call you multiple times via
FaceTime; otherwise, only the first call rings through, and the others are ignored under the
assumption you would have picked up the first time if you were available. It is meant to reduce the
annoyance of those who keep calling and calling when they don't get a response.

Finally, the Share Buttons option in the list at the left of the Notifications system preference is how
you control whether the buttons to initiate social posts appear at the top of the Notification
Center. Click Share Buttons, and then select or deselect, as desired, the Show Share Buttons in
Notification Center check box in the right side of the Notifications system preference.

eoo Motifications
[« > || ShowaAll | Q

Notification Center shows your alerts in the upper-right of your screen, without interrupting what
you're doing. Show and hide Notification Center by clicking its icon in the menu bar.

C ' Do Not Disturb Scroll down in Notification Center

to turn on Do Not Disturb.

In Notification Center

= Share Buttons
T Turn on Do Not Disturb:

@ Messages [E]From: 10:00 PM |§| to:  7:00 AM |§|
|| When the display is sleeping

- Mail

h (™ When mirroring to TVs and projectors
E Calendar When Do Not Disturb is turned on:

B (™ Allow FaceTime calls from: | Everyone & |
- Reminders — .
: || Allow repeated calls
E Ti When enabled, a second FaceTime call from the same
|‘!’k’\ el person within three minutes will not be silenced.
@ Safari
Sort Notification Center: | Manually % | (2)

1.20 You can schedule when the MacBook Pro enters Do Not Disturb mode in the Notifications system
preference.
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Working with Monitors

Current MacBook Pros have 13- or 15-inch LCD screens. No matter which display size you have,

more is always better. Fortunately, you can maximize the amount of information you see on your
MacBook Pro’s screen by configuring its display. For even more working room, you can attach and
use an external monitor, or you can broadcast your MacBook's output to an Apple TV using AirPlay.
For the ultimate in Desktop space, you can connect your MacBook Pro to a projector. When you
use an external monitor or projector, you can display the same image on the MacBook Pro and the
external device, or you can expand your Desktop over both monitors. You can also configure the
Desktop picture on your monitors to make your MacBook Pro’s appearance more interesting.

Configuring the MacBook Pro’s LCD screen

Although the physical size of the MacBook Pro’s LCD screen is fixed, the amount of information
that can be displayed on it (its resolution) is not. Setting the appropriate resolution is a matter of
choosing the largest that you can view comfortably with no eyestrain. There are standard resolu-
tions you can use, but which of these is available to you depends on the specific MacBook Pro you
are using. For example, the 13-inch model has a different set of resolutions than the 15-inch
model. Likewise, models with Retina screens support yet a different set of options. Follow these
steps to find your maximum resolution:

1. Open the Displays system preference. As shown in Figure 1.21, the name shown at the
top of the pane matches the monitor it configures.

2. Go to the Display pane if it's not already visible.

3. To use the resolution that is optimal for the built-in LCD screen, select Best for
Display and skip to Step 6. The screen’s resolution is set to what Apple considers opti-
mal for its size.

4. To manually select a resolution, select Scaled. In the Resolutions section, you see all
the resolutions supported by your MacBook Pro’s screen. Resolutions are shown as the
number of horizontal pixels by the number of vertical pixels, such as 1280 X 800. Larger
values have a higher resolution. Some resolutions are stretched so they fill the screen;
the MacBook Pro has a widescreen format display.

5. Select a resolution. The screen updates to the resolution you selected.

6. Drag the Brightness slider to the right to make the screen brighter, or drag it to the
left to make it dimmer. Or select the Automatically Adjust Brightness check box to let
OS X adjust the screen for you based on the surrounding lighting; it uses the MacBook
Pro’s camera to determine that lighting.
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7. Hide the System Preferences application by pressing 38 +H.

8. Open several windows on the Desktop.

Built-in Display

Resolution: (| Best for display
(*)Scaled

1680 x 1050
1152 x 720
1024 x 640

"

Brightness: i
™ Autom atically adjust brightness

| Gather Windows | '\?/'

1.21 Use the Displays pane to maximize the amount of room you have on your Desktop, while still
being comfortable for you to view.

those without them. On MacBook Pro with Retina screens, you can choose the Scaled
option, but instead of selecting an actual resolution, you choose different scales.

They look like different resolutions because the text and images change relative size

the same as they do when you change the resolution.

9. If you can see the information on the screen comfortably, switch to the System
Preferences application (such as from the Dock) and select a higher resolution.

10. Repeat Steps 7 through 9 until you reach the maximum resolution or until the text
is too small to comfortably read. Set the resolution to the highest that was com-

fortable to read.

11. Close the Displays system preference when done.
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Connecting and configuring an
external monitor with a cable

Another way to add more screen space to your MacBook Pro is to connect an external monitor. This

lets you add more screen real estate without shrinking the display, so you don’t risk text getting too
small to read. Plus, when you use multiple monitors, you can treat each one as a separate Desktop,
making it easy to put, for example, photo-editing applications on a large external monitor where
the extra size really matters while keeping your e-mail on the MacBook Pro’s smaller screen.

You can use an external monitor in two ways: as an extension of your Desktop so you can open
additional windows on it, or as video mirroring, which means the same information appears on
all monitors.

When choosing an external monitor, the two most important considerations are size and cost.
Larger monitors are better because they give you more working space. However, they tend to be
more expensive, depending on the brand you choose. In most cases, if you choose the largest
display you can afford from a reputable manufacturer, such as Apple, ViewSonic, or Samsung,

you'll be in good shape.

To add an external monitor, connect it to the MacBook Pro’s Thunderbolt port. To do this, you
need a MiniDisplayPort-to-DVI adapter that converts the Thunderbolt connection to the standard
DVI connector used on most modern displays. You can also use a MiniDisplayPort-to-VGA adapter
to use your MacBook Pro with older displays or a MiniDisplayPort-to-HDMI adapter to connect to a
TV or monitor that uses that TV-standard connector. Also, some MacBook Pro models, such as
those with Retina displays, come with an HDMI port, so no adapter is needed.

Follow these steps to attach an external monitor to a MacBook Pro:

1. Connect one end of the display’s video cable to the MiniDisplayPort adapter and
the other end to the DVI, VGA, or HDMI port on the monitor, depending on the kind
of adapter you have.

2. Plug the MiniDisplayPort adapter into the Thunderbolt port.
3. Connect the display to a power source.

4. Power up the display.
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After an external display is connected to your MacBook Pro, follow these steps to configure it:

1. Open the Displays system preference. The Displays system preference opens on both
the MacBook Pro’s screen and the external monitor. The name of the pane on the
MacBook Pro’s screen is Built-in Display (it was named Color LCD before OS X Mavericks).
The name of the pane on the external monitor is the name of that monitor. Also, notice
that the Displays system preference on the primary display (by default, the MacBook
Pro’s screen) contains the Arrangement pane.

2. Go to the Arrangement pane, shown in Figure 1.22, on the Displays system prefer-
ence on the MacBook Pro’s screen. You see an icon representation of each display. The
display marked with the menu bar at the top is the primary display, meaning where the
menu bar and Dock appear by default.

800 Thunderbolt Display
[« > | [ Showall | (Q )

| Display A.rra.ngement Color |

To rearrange the displays, drag them to the desired position.
To relocate the menu bar, drag it to a different display.

|_| Mirror Displays

AirPlay Display: | Off =

[21 Show mirroring options in the menu bar when available | Gather Windows | .7.

1.22 The MacBook Pro’s screen is on the right (with the menu bar at the top, indicating that it is the
primary display), while the external monitor is on the left.
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3. Drag the external monitor’s thumbnail to where you want it relative to the

MacBook Pro’s screen. Typically, this should match the physical location of the monitor
compared to the MacBook Pro, such as to its side. But you can arrange the external mon-
itor above, below, and to the side of the MacBook Pro. To move the pointer from one
monitor, you must go through where they touch in the Arrangement pane. For example,
if the external monitor is to the left of the MacBook Pro’s screen in the Arrangements
pane, you must move the pointer past the left edge of the MacBook’s screen for it to
move on to the external monitor’s screen, and you must reverse that motion to get back
to the MacBook's screen.

4. If you want the external display to be the primary one, drag the menu bar from the
MacBook Pro’s screen thumbnail onto that of the external monitor. When you
release the trackpad button, the menu bar jumps to the external display.

5. Go to the Displays system preference for the external monitor. You can move the
mouse to its monitor to get to it, or you can click Gather Windows to move the Displays
system preference to the current monitor.

6. To change the resolution, click Scaled and then select the desired resolution for the
external monitor from the list of those available. If the resolutions are significantly
different between the two displays, you see a big change in appearance when you move
a window between them. You may have to resize a window on one display that was the
right size on the other.

7. If the Refresh rate menu appears, choose the highest rate available.

8. Quit the System Preferences application.

You can now use the space on the external display like you use the internal display. To place a
window on the external display, drag it from the MacBook Pro display onto the external one. You
can move windows, the pointer, and other items from one display to the other just as you can
move them around the MacBook Pro internal display. You can configure windows on each display
S0 you can see many at the same time. For example, you may want your primary documents open
on the external display and your e-mail application open on the MacBook Pro display. The menu
bar remains on the primary display, so if you do most of your work on the external one, you may
want to make it the primary display to make menu access easier.

To stop using the external display, disconnect it from the MacBook Pro. If it was the primary dis-
play, the MacBook Pro’s screen automatically becomes the primary one, and any open windows
on the external monitors move onto the MacBook Pro’s screen.
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the past, they were fixed to the primary display, which made using applications on other

monitors difficult. Now, the menu bar and Dock move to whatever monitor is active—
that is, wherever your pointer is. Just give the MacBook Pro a few seconds to move the
Dock to the new monitor when you first try to use it. Likewise, full-screen applications
can now appear on non-primary displays, leaving the other monitors unaffected.

Connecting and configuring an
external display with AirPlay

AirPlay enables a MacBook Pro to wirelessly broadcast its video to an Apple TV. This is a great way
to display your MacBook Pro’s output on a larger display, such as an HDTV. In OS X Mavericks, you
can even use an Apple TV as a working Desktop for your MacBook Pro, not just as a way to deliver
video or presentations.

To use AirPlay, your MacBook Pro must be on the same network as the Apple TV, and of course
your Apple TV must be on and connected to a TV or other display. When this is the case, using
AirPlay is a snap.

Follow these steps to set up external display via AirPlay:

1. Besure AirPlay is enabled on the Apple TV. In the Apple TV's Settings screen, select
AirPlay, and then select AirPlay On. Your MacBook Pro and Apple TV should find each

other automatically.

2. Inthe Displays system preference on the MacBook Pro, choose Apple TV in the AirPlay
Mirroring menu. Your MacBook Pro Desktop appears on the Apple TV display. If the
Displays icon is in your menu bar, its icon should change to that of the AirPlay symbol; if so,
you can click that icon and choose AirPlay rather than use the Displays system preference.

3. Inthe Displays system preference, be sure to select the Overscan Correction and
Show Mirroring Options in Menu Bar When Available check boxes. The first option
ensures the MacBook Pro’s display fits fully on the screen connected to the Apple TV,
and the second option ensures that the AirPlay controls are available from the MacBook
Pro’s menu bar. Figure 1.23 shows the system preference.

4. Using the menu bar’s Apple TV menu, choose the resolution to display, as Figure 1.24
shows. To fit the resolution to the display’s size, choose Apple TV; this makes your MacBook's
resolution larger, fitting less on the screen. To fit the resolution to the MacBook Pro’s screen,
choose Color LCD or, if you're using an external monitor, the name of that monitor.

40



apter 1 How Can'I'Use My Desktop Space Efriciently?

@0o Built-in Display

[« > | [ showall | (Q )

ploc=00 | Arrangement | Color I

Optimize for: | Built-in Display v:

Resolution: 1680 x 1050
1280 x 800
1152 = 720
1024 x 640

"

Brightness: )
™ Autom atically adjust brightness

AirPlay Display: | Apple TV 5 | (™ Overscan correction

™ Show mirroring options in the menu bar when available | Gather Windows | I\'}/I

1.23 The Display system preferences for using an Apple TV.

When you use AirPlay, anything that appears on your Desktop also appears on the Apple TV display.
To stop using AirPlay, choose Turn Off AirPlay Mirroring from the AirPlay menu in the menu bar.

Using a projector

If you make presentations, conduct training, or just want a really big display, a projector is the way
to go. With one of these, you can broadcast your MacBook Pro display to very large sizes for easy
viewing by an audience. Using a projector is similar to using an external display, so if you can work
with those, you can work with a projector.

tively low value, such as 1024 x 768. If the projector doesn't display, reduce the reso-

lution to see whether it starts displaying. When it displays, increase the resolution

until the projector is no longer capable of displaying the image.
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Disconnect AirPlay Display

Connect To AirPlay Display:
+ Apple TV
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+ Extend Desktop

Open Displays Preferences...

_ Built-in Display

Resolution: () Best for display
(=) Scaled
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1280 x 800
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1024 x 640

Projects

# Automatically adjust brightness

Gather Windows ®

1.24 Use this Apple TV menu to configure how your MacBook Pro’s output appears on an Apple TV.

Purchasing a projector is a bit more complicated and, usually, more expensive than purchasing a
display. This list includes a few of the many things to consider when buying a projector:

@ Size. A smaller projector is easier to carry, and as you move through airports and such,
this is very important. Smaller projectors of the same quality are more expensive than
larger ones, so find a balance between portability and price.

@ Resolution. There is more variability in the resolution of projectors than displays. At the
lower end of the price range, you'll find projectors that are capable of only 800 X 600
resolution. Many Mac applications can’t even run at a resolution this low. The lowest res-
olution you should consider for a projector is 1024 X 768 (also called XGA). Higher reso-
lutions are better but also more expensive.

@ Brightness. The brightness of projectors is specified in lumens. Projectors with higher
lumen ratings are generally able to throw larger and brighter images farther. How many
lumens you need depends on many factors, most of which are probably beyond your con-
trol (such as the brightness levels of the location in which you'll be using the projector).
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@ Throw range. This measures the closest and farthest distances at which the projector
can be used.

@ Video interface. Like displays, the options for projectors include DVI, VGA, and HDMI.
However, most projectors provide other input options, such as component, composite,
and S-video. These are important if you use the projector with other sources, such as a
DVD player.

@ Bulb life. Like all other bulbs, the one in a projector eventually fails and must be
replaced. Unlike bulbs for lights, you can expect to pay hundreds of dollars for a replace-
ment projector bulb, so try to get one with a long life.

@ Cost. Expect to pay several hundred dollars for a good-quality projector that has at least
1024 X 768 resolution.

If the projector isn't projecting an image, use its source menu to select the source to

which your MacBook Pro is connected. You can also use the Detect Displays com-

mand on the Displays menu in the menu bar or on the Displays system preference’s
Display pane to see if that restores an image on the projector.

Using a projector is very similar to using an external display. You connect a projector to the
MacBook Pro using the appropriate MiniDisplay adapter, depending on what type of connector
the projector uses. You can also connect a projector to an Apple TV, either directly through the
Apple TV's HDMI port or using an adapter such as Kanex’s ATV Pro HDMI-to-VGA adapter.

Using mirroring versus showing
separate screens

When you've plugged in an external monitor to the MiniDisplayPort or are using an Apple TV, you
can mirror the contents of your MacBook Pro’s screen to that other display or you can treat the
other display as an additional space to place applications and Finder windows.

In the Displays system preference’s Arrangement pane, select Mirror Displays to enable mirroring;
deselect it to make the monitors separate. If the monitors are separate, drag their positions to
what makes sense for you—side by side, one atop the other, and so on. The display thumbnail
with the bar at the top is the primary display; double-click a monitor’s thumbnail to make it the
primary display.

43



VIaCBoOK Pro Portable Genius, dition

In OS X Mavericks, you can use the Apple TV as a separate monitor, as Figure 1.25 shows—not just
mirror to it as in previous versions.

#® System Preferences Edit View Window Help B O D 3 T4 G Thusddm Q =

Bullt-in Display

oo T
Resolution: (| Best for display
(») Scaled
1680 = 1050
1280 x 800
088, . Thunderbolt Display
Brig -
—{ Display m’ Color |
Apple TV To rearrange the displays. drag them to the desired position.

To relocate the menu bar, drag it to a different display.

|| Mirror Displays
AlrPlay Display: | Apple TV +| M Overscan carrection
[ Show mirroring options in the menu bar when available | Gather Windows | (7)

1.25 Using the Apple TV as a separate monitor, in addition to a Thunderbolt display attached to the
MacBook Pro and the MacBook Pro’s LCD screen.

you want some monitors to be mirrored and others to be separate, first connect only

those you want mirrored to the primary display and then enable screen mirroring.
Then connect the other monitors; they won’t be mirrored.

Setting the Desktop Background

| confess that this section has nothing to do with efficiency. However, there’s more to life than
being efficient. Because you stare at your Desktop so much, you may as well have something inter-
esting to look at, which is where Desktop pictures come in. You can set any image to be your
Desktop picture. You can use the default images included with OS X, image files you create or
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download from the Internet, or (best of all) photos from your iPhoto or Aperture libraries. You can

also configure your MacBook Pro so the Desktop background changes over time, to keep it even

more interesting.
Perform these steps to configure your Desktop background:

1. Open the Desktop & Screen Saver system preference.

2. Go to the Desktop pane. On the center-left side of the pane are the sources of images
from which you can select pictures for your Desktop, including Apple (default images),
iPhoto (images from your iPhoto library, if iPhoto is installed), Aperture (images from
your Aperture library, if Aperture is installed), and Folders (your Pictures folder plus any
others you add).

[Pl ground on the external monitor separately from what you set for the MacBook Pro’s

LCD screen.

3. Expand the source of images you want to work with by clicking the disclosure tri-
angle to its left. The contents of that source appear. For example, if you expand the
Apple source, you see its folders. If you expand the iPhoto source, you see Events,
Photos, photo albums, and so on.

4. Select a source of images in the left side of the pane. Thumbnails of the images in
that source appear in the right side of the pane.

5. Click the image that you want to apply to the Desktop, or choose a folder and
select the Change Picture check box. If you select a specific image, it fills the Desktop
and you see it in the image well at the top of the Desktop pane, as shown in Figure 1.26.
If you select a folder and the Change Pictures check box, you see an icon representing
rotating images at the top of the pane, as shown in Figure 1.27. Use the adjacent menu
to control how often the pictures change, and use the Random Order check box to have
them change at random rather than in the order they appear in the folder.

Note to move to and select the folder containing the images you want to use. After you
click the Choose button, that folder appears as a source on the list and you can work

with it just like the default sources.
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800 Desktop & Screen Saver
[« > ][ Showall | a )
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[ Desktop Pictures
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Random order
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1.26 I've selected an image from the Apple library as my Desktop background.

.. Control to move to the Desktop for which you want to set a picture, set it, and then
[PITE switch to the next Desktop.

6. If the image you selected isn’t the same proportion as your current screen resolu-
tion, use the pop-up menu that appears just above the thumbnail pane to choose
how you want the image to be scaled to the screen. For example, choose Fit to Screen
to have photos scaled so that they fit the screen (there may be blank margins on the
sides in this case), Fill Screen to have photos scaled to fill the screen (some of the image
may be cropped out to avoid having blank margins), Tile to have images that are smaller
than the Desktop fill the Desktop space as a series of tiles, and so on.
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I've selected a folder of images and the Change Picture option so the background picture changes
automatically.

If the image doesn’t fill the screen, click the Color button that appears to the right
of the menu when it can be used. The Color Picker opens. Use it to choose the back-

ground color that appears behind photos when they don't fill the Desktop.

To make the menu bar translucent so you can see the Desktop background behind
it, select the Translucent Menu Bar check box. When this option is not selected, the

menu bar becomes a solid color.

Quit the System Preferences application. Enjoy your Desktop’s new look!



